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Questions? 

Please contact our West Bank Treasury Management team at 515-222-2300 
or email WBTreasury@westbankstrong.com.
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Establish a New ACH Payment
You can generate a new ACH payment using the + New payment functionality.
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To establish a new ACH payment
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system
displays the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Select + New payment. The system displays the
New payment dialog box.

5. Select the appropriate Type (for example, Payroll -
PPD) from the drop-down list. Click Continue. The
system displays the New payment page.

6. Type the Description of the transfer (for example,
Monthly Payroll).

7. Select the tax identification number that the system
associates with the transfer from the Tax
identification number drop-down list.
Note:

In some instances, the system associates an
ACH user (for example, GeorgeWashington)
with multiple companies (for example,
Washington Farms andWashington
Orchards). In these cases, the system
populates the Tax identification number
drop-down list with each of the companies that
it associates with the user.

8. In the Effective date field, type the date you intend
the new ACH transfer to process.

9. Select the Repeat check box to establish the
frequency with which the new ACH transfer occurs.

10. Select the Frequency from the drop-down list to
establish how often the transfer occurs.

Note:
When you select a recurring frequency value
other thanNone, the system populates the
transfer with an additional date field titledEnd
date. Type the end date of a recurring transfer
as the End date.

11. Select the appropriate option for processing a 
recurring transfer on a nonprocessing date from the For 
non-business day use drop-down list.

12. Type the Company description.

13. In the Pay from section, select the appropriate 
Account from the drop-down list and type the Amount 
that the system debits from the account.

14. In the Pay to section, complete the following:
a. Type the Name of the recipient.
b. Type the Identification number of the recipient.
c. Type the Routing transit number of recipient.
d. Type the Account number of the recipient.
e. Select the appropriate Account type.
f. Type the Amount to deposit in the recipient's 

account.

15. Click Complete ACH, then answer the Security 
Challenge by clicking the button on your token and 
typing in the number that is displayed. The system will 
then display the processing results page.

16. Repeat steps 4 through 15 to generate additional 
transfers.

17. Sign out of eCorp Business Online Banking.



Establish a New ACH Collection
You can generate a new ACH collection using the + New ACH collection functionality.
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To establish a new ACH collection
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Select + New collection. The system displays the
New collection dialog box.

5. Select the appropriate Type (for example,
Prearranged payment- PPD) from the drop-down list.
Click Continue. The system displays the New
collection page.

6. Type the Description of the transfer (for example,
Monthly service contract).

7. Select the tax identification number that the system
associates with the transfer from the Tax
identification number drop-down list.
Note:
In some instances, the system associates an
ACH user (for example, GeorgeWashington)
with multiple companies (for example,
Washington Farms andWashington
Orchards). In these cases, the system
populates the Tax identification number
drop-down list with each of the companies that
it associates with the user.

8. In the Effective date field, type the date you intend
the new ACH transfer to process.

9. Select the Repeat check box to establish the
frequency with which the new ACH transfer occurs.

10. Select the Frequency from the drop-down list to
establish how often the transfer occurs.

Note:
When you select a recurring frequency value
other thanNone, the system populates the
transfer with an additional date field titledEnd
date. Type the end date of the recurring
transfer.

11. Select the appropriate option for processing a 
recurring transfer on a nonprocessing date in the For 
non-business day use drop-down list.

12. Type the Company description.
13. In the Pay from section, select the appropriate 
Account from the drop-down list and type the Amount 
that the system debits from the account.

14. In the Pay to section, complete the following:
a. Type the Name of the recipient.
b. Type the Identification number of the recipient.
c. Type the Routing transit number of recipient.
d. Type the Account number of the recipient.
e. Select the appropriate Account type.
f. Type the Amount to deposit in the recipient's 

account.

15. Click Complete ACH, then answer the Security 
Challenge by clicking the button on your token and 
typing in the number that is displayed. The system will 
then display the processing results page.

16. Repeat steps 4 through 16 to generate additional 
transfers.

17. Sign out of eCorp Business Online Banking.
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Inquire into an ACH Payment or Collection
You can find information about ACH transfers using Inquire ACH Transfer 
functionality.

To inquire into an ACH payment or collection
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Type search criteria as needed then click Submit.
The system displays a list of transfers on the ACH
Activity page.

5. Locate the ACH transfer that you want to inquire into
and click the down arrow next to the transfer to view a
brief overview of the transfer.

6. Locate the ACH transfer that you want to inquire into
and click on the Description hyperlink that the system
associates with that particular transfer. The system
displays the ACH transfer details page.

7. Review the ACH transfer. Complete steps 7 through
10 as needed.

8. To generate a report, click Report. They system
displays the Transfer report dialog box.

9. Select PDF (.pdf) or Comma separated value (.csv)
from the Format drop-down list and click Download
report.

10.Click Return to ACH activity. The system displays
the ACH Activity list page.

11.Repeat steps 2 through 10 to inquire into additional
ACH transfers.

12.Sign out of eCorp Business Online Banking.



Modify an ACH Payment or Collection
You canmodify ACH transfers using Change ACH Transfer functionality.
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To modify an ACH payment or collection
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Click Edit for the appropriate transfer from the list. The
system displays the edit page for the transfer.

5. In the Description field, modify the name of the
transfer as needed (for example, Wash Orchards
Payroll becomes Wash Orch Pay).

6. Select the tax identification number that the system
associates with the transfer from the Tax
identification number drop-down list.

7. Type the date that you intend the ACH transfer to
process in the Effective date field.

8. Modify the frequency with which the ACH transfer
occurs in the Frequency field.
Note:

When you select a recurring frequency value
other thanNone, the system populates the
transfer with an additional date field titledEnd
date. Type the end date of the recurring
transfer.

9. Select the appropriate payment schedule conditions
from the For non-business day use drop-down list.

10.Modify the description according to your needs in the
Company description field.

11.Modify the information in the fields populating the
Pay from section and the Pay to section as needed.

12.Click Complete ACH, then answer the Security
Challenge by clicking the button on your token and
typing in the number that is displayed. The system
will then display the processing results page.

13.Sign out of eCorp Business Online Banking.
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Review ACH Transfers
Review ACH Transfer functionality ensures that individual ACH users or institutions can review and approve ACH transfers 
before the system processes them.

To review an ACH transfer
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select the appropriate check boxes for the transfers
listed in the ACH section of the Payments & Transfers
widget on the home page.

3. Select Review ACH Transfer and then click Submit.
The system displays the Review ACH Transfers list.

4. Locate the ACH transfers that require review from the
ACH section of the Payments Transfers widget on the
home page and select Approve or Disapprove. The
system displays the Security Challenge dialog box.
Note:

You can approve or disapprove all of the ACH
transfers populating the ACH Transfers list by
selecting theDescription check box.

5. To answer the Security Challenge, click the
button on your token and type in the
number that is displayed. Then click
Complete Challenge.

6. Sign out of eCorp Business Online Banking.
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Delete ACH Transfers
Delete ACH Transfer functionality ensures that an ACH user can delete saved ACH transfers or ACH transfers that have not 
completed processing.

To delete an ACH transfer
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Use the Search activity fields to narrow the list of
ACH transfers that the system returns.

5. Click Delete for the appropriate transfer. The system
displays the Delete transfer page

6. Recurring ACH Transfers Only. Select the
appropriate value from the Deletion type drop-down
list.

7. Click Delete ACH. The system displays the
processing results page.

8. Repeat steps 2 through 7 to delete additional ACH
transfers.

9. Sign out of eCorp Business Online Banking.



Establish a New ACH Transfer Using an Existing ACH Transfer
You can generate new ACH transfers using an existing ACH transfer when you use New Change ACH Transfer functionality.
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To establish a new ACH transfer using an 
existing ACH transfer
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Locate the appropriate transfer that you want use
and click Copy. The system displays the [Transfer
name] page.

5. In the Description field, type the name of the new
transfer (for example, Wash Orchards Payroll).

6. Select the tax identification number that the system
associates with the transfer in the Tax identification
number drop-down list.
Note:
In some instances, the system associates an
ACH user (for example, GeorgeWashington)
with multiple companies (for example,
Washington Farms andWashington
Orchards). In these cases, the system
populates the Tax identification number
drop-down list with each of the companies that
it associates with the user.

7. Type the date that you intend the new ACH transfer to 
process in the Effective date field.

8. Optional. Select the Repeat check box to define the 
Frequency that the transfer occurs, the End date and 
the For Non-business day use option.

9. Type the appropriate information in the fields 
populating the Transfer from section and the Transfer 
to section.

10. Click Complete ACH, then answer the Security 
Challenge by clicking the button on your token and 
typing in the number that is displayed. The system 
will then display the processing results page.

11. Click Return to ACH activity to return to the ACH 
Activity list or click Save as template to initiate the 
process of establishing a new template based on the 
transfer that you just established.

12. Repeat steps 2 through 12 to generate additional 
transfers.

13. Sign out of eCorp Business Online Banking.



Generating PDF Formatted Reports – Transfers
Print functionality provides users with the ability to print ACH transfer and ACH transfer template data in a PDF format when
inquiring into individual transfers and transfer templates.
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Generate PDF formatted reports for ACH 
transfers
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Use the search criteria to narrow the list of transfers
and click Search. The system refreshes the page with
the new search results.

5. Click Report to generate a report for all items that the
system displays. The system displays the Activity
report dialog box.

6. Select the appropriate Type check boxes (for
example, File information, Batch information, or
Transactions) for the information that you want the
system to include in the report.
Note:

If you select more than one Type check box,
the system compiles the report in a Zip file.

7. Select PDF from the Format drop-down list.
8. Click Download report. When the system prompts

you, select the local folder to which you want to save
the formatted report.
Note:
By default, the system generates a PDF
formatted report that uses the naming
convention TransferDetail_
MMDDYYYYHHMMSS.pdf.

MM = themonth that the system generates
the PDF report.
DD = the day that the system generates the
PDF report.
YYYY = the year that the system generates
the PDF report.
HH = the time of day in hours that the system
generates the PDF report.

MM = the time of day in minutes that the
system generates the PDF report.
SS = the time of day in seconds that the
system generates the PDF report.

9. Once you save the PDF formatted report, open the
report in Adobe Reader. The system displays the PDF
formatted report for the ACH transfer.

10.When you complete your review of the report, close
Adobe Reader.

11.Repeat steps 3 through 10 for each set of
ACH transfers that you want to generate a PDF
formatted report for.

12. Sign out of eCorp Business Online Banking.



Generating PDF Formatted Reports – Templates
Print functionality provides users with the ability to print ACH transfer and ACH transfer template data in a PDF format when
inquiring into individual transfers and transfer templates.
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Generate PDF formatted reports for ACH 
templates
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Click the Templates tab. The system displays a list of
templates.

5. Click the Report button. The system displays the
Template report dialog box.

6. Select the appropriate check boxes for the templates
that you want to include in the report, select PDF
(.pdf) from the Format drop-down list and click
Download report. When the system prompts you,
select the local folder to which you want to save the
formatted report.
Note:

By default, the system generates a PDF
formatted report that uses the naming
convention TemplateList_
MMDDYYYYHHMMSS.pdf.

MM = themonth that the system generates
the PDF report.
DD = the day that the system generates the
PDF report.
YYYY = the year that the system generates
the PDF report.
HH = the time of day in hours that the system
generates the PDF report.
MM = the time of day in minutes that the
system generates the PDF report.
SS = the time of day in seconds that the
system generates the PDF report.

7. Once you save thePDF formatted report, open the report
in AdobeReader. The system displays thePDF
formatted report for theACH template.

8. When you complete your review of the report,
close Adobe Reader.

9. Repeat steps 4 through 8 for each set of
ACH transfers that you want to generate a PDF
formatted report for.

10.Sign out of eCorp Business Online Banking.



Generate CSV Formatted Reports – Transfers
Export functionality provides users with the ability to generate ACH transfers in a CSV formatted report when inquiring into
individual transfers and transfer templates.
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Generate CSV formatted reports for ACH 
transfers
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Use the search criteria to narrow the list of transfers
and click Search. The system refreshes the page with
the new search results.

5. Click Report to generate a report for all items that the
system displays. The system displays the Activity
report dialog box.

6. Select the appropriate Type check boxes (for
example, File information, Batch information, or
Transactions) for the information that you want the
system to include in the report.
Note:

If you select more than one Type check box,
the system compiles the report in a Zip file.

7. Select Comma separated values from the Format
drop-down list.

8. Click Download report. When the system prompts
you, select the local folder to which you want to save
the formatted report.
Note:
By default, the system generates the CSV
formatted report using the naming convention
TransferDetail_MMDDYYYYHHMMSS.csv.

MM = themonth that the system generates
the CSV report.
DD = the day that the system generates the
CSV report.
YYYY = the year tat the system generates the
CSV report.
HH = the time of day in hours that the system
generates the CSV report.

MM = the time of day in minutes that the
system generates the CSV report.
SS = the time of day in seconds that the
system generates the CSV report.

9. Once you save the CSV formatted report, open the
report in a program like Microsoft Excel. The system
displays the CSV formatted report for the ACH
transfer.

10.When you complete your review of the report, close
the report.

11.Repeat steps 3 through 10 for each set of ACH
transfers that you want to generate a CSV formatted
report for.

12. Sign out of eCorp Business Online Banking.



Generating CSV Formatted Reports – Templates
Print functionality provides users with the ability to print ACH transfer and ACH transfer template data in a CSV format when
inquiring into individual transfers and transfer templates.
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Generate CSV formatted reports for ACH 
templates
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Click the Templates tab. The system displays a list of
templates.

5. Click the Report button. The system displays the
Template report dialog box.

6. Select the appropriate check boxes for the templates
that you want to include in the report, select Comma-
separated value (.csv) from the Format drop-down
list and click Download report. When the system
prompts you, select the local folder to which you want
to save the formatted report.
Note:

By default, the system generates a CSV
formatted report that uses the naming
convention TemplateList_
MMDDYYYYHHMMSS.csv.

MM = themonth that the system generates
the CSV report.
DD = the day that the system generates the
CSV report.
YYYY = the year that the system generates
the CSV report.
HH = the time of day in hours that the system
generates the CSV report.
MM = the time of day in minutes that the
system generates the CSV report.
SS = the time of day in seconds that the
system generates the CSV report.

7. Once you save theCSV formatted report, open the
report inMicrosoft Excel. The system displays theCSV
formatted report for theACH template.

8. When you complete your review of the report,
close Microsoft Excel.

9. Repeat steps 4 through 8 for each set of
ACH transfers that you want to generate a CSV
formatted report for.

10.Sign out of eCorp Business Online Banking.



Import a NACHA File Using an Existing Template
Import ACH Transfer functionality for NACHA files enables you to import a stored NACHA transfer file against a stored
template. The system validates the transfer type and amount range (total transfer amount) stipulated in a selected template
against the values in the imported ACH file. If the validation fails, the system displays an error message and the import
process cannot continue.

Note:
ACH users who do not have access to stored templates can only import files without using a template.

2/22/2019 16

4.0.1 Confidential - Limited

Quick Reference Guide

Import a NACHA file formatted transfer using 
an existing template
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Click the Import file hyperlink. The system displays
the Import file page.

5. Select NACHA as the Import type.
6. In the File location field, select Browse. The system

displays the Choose File to Upload window.

7. Select the file to upload and click Open. The system
displays the Import file page.

8. Select the appropriate Template from the drop-down
list.

9. Click Continue. The system displays the File
summary page.

10.Click the Review ACH button. The system displays
the transfer Activity edit page.

11.Review the transfer details and make any desired
changes, and then click Complete ACH. Next,
answer the Security Challenge by clicking the button
on your token and typing in the number that is
displayed. The system will then display the
confirmation page.

12.Sign out of eCorp Business Online Banking.



Import a Non-NACHA File Using an Existing Template
Import ACH Transfer functionality for non-NACHA files enables users to import a stored transfer file against an existing
template. The ACH transfer system validates the tax identification number, transfer type, and amount range (that is, total
transfer amount) stipulated in a selected template against the values in the imported ACH file. If the validation fails, the system
displays an error message and the import process cannot continue.

Note:
ACH users who do not have access to stored templates can only import files without using a template.
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Import a Non-NACHA formatted transfer using 
an existing template
1. Sign in to eCorp Business Online Banking. The 

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays 
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer 
page.

4. Click the Import file hyperlink. The system displays 
the Import file page.

5. Select Non-NACHA.
6. In the File location field, select Browse. The system 

displays the Choose File to Upload window.

7. Select the file to import and click Open. The system 
displays the Import file page.

8. Select the appropriate Template from the drop-down 
list.

9. Click Continue. The system displays the New 
NACHA file import template page.

10.Review the content. If the system prompts you, type 
the Effective date and click Continue. The system 
displays the Import file [File Name] page.

11.Click Complete ACH, then answer the Security 
Challenge by clicking the button on your token and 
typing in the number that is displayed. The system 
displays a status message about the imported file.

12.Click Return to ACH activity.

13.Sign out of eCorp Business Online Banking.



Import a NACHA File Without Using a Template
Import ACH Transfer functionality for NACHA files enables users to import a stored NACHA transfer file without validating it
against the fields stored in an existing NACHA template.

Note:
ACH users who do not have access to stored templates can only import files without using a template. The import
process does not display the Template field for these users.

2/22/2019 18

4.0.1 Confidential - Limited

Quick Reference Guide

Import a NACHA file without using a template
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Click the Import file hyperlink. The system displays
the Import file page.

5. Select NACHA.
6. In the File location field, select Browse. The system

displays the Choose File to Upload window.

7. Select the file to import and click Open. The system
displays the Import file page.

8. Select Import without using a template from the
Template drop-down list.

9. Select the tax ID number from the Tax identification
number drop-down list.

10.Select the appropriate ACH transfer type from the
Type drop-down list.

11.Click Continue. The system displays the Import file -
[File Name] page.

12.Click Review ACH. The system displays the transfer
Activity edit page.

13.Review the transfer details and make any desired
changes, and then click Complete ACH. Next,
answer the Security Challenge by clicking the button
on your token and typing in the number that is
displayed. The system will display the confirmation
page.

14.Sign out of eCorp Business Online Banking.



Import a Non-NACHA File Using a New Template
Import ACH Transfer functionality for non-NACHA files enables users to import a stored transfer using a new template. The
system validates the transfer type and any other applicable information. If the validation fails, a message displays and the
import process cannot continue.

Note:
ACH users who do not have access to stored templates can only import files without using a template.
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Import a Non-NACHA file using a new template
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Click the + Import file hyperlink. The system displays
the Import file page.

5. In the Import file section, complete the following:
a. Select Non-NACHA.
b. Select the File location using the Browse button.
c. Select Create a new template from the

Template drop-down list.
d. Select the ACH transfer type from the Type drop-

down list.

6. Click Continue. The system displays the Import file
page with all the import details.

7. Complete the following:
a. Type the Template name.
b. Select the Tax identification number from the

drop-down list.
c. Select the Template group from the drop-down

list.
d. Select the appropriate Insert decimals into

amounts option.
e. Select Delimited or Fixed width as the file

format.
f. Type the number of Header and Footer rows to

exclude.

g. Select the Text qualifier from the drop-down list.
h. Select all appropriate Column options.

8. In the Apply additional values section select the
appropriate Type from the drop-down list.

9. In the Offset account options section, select whether
you want the system to apply an offset.

10. In the Effective date section, select whether the
system use the Date in file, Prompt for date, or the
Default current business date.

11. In the User access section, select either All current
and future users or Specific users.

12.Click Continue. The system displays the Import file -
[Template Name] page which provides an overview
of the data mapping.

13. Type the Effective date and click Continue. The 
system displays the File summary page.

14. Click Complete ACH or if you want to review 
the file data, click Review ACH. Next, answer 
the Security Challenge by clicking the button on 
your token and typing in the number that is 
displayed. The system will then display the 
confirmation page.

15.Sign out of eCorp Business Online Banking.
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Import ACH Comingled Files
To import an ACH Comingled file

1. Sign in to eCorp Business Online Banking. The
system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Click the Import file hyperlink. The system displays
the Activity tab for importing files.

5. Complete the following:
a. Select NACHA.
b. In the File location field, select Browse. The

system displays the Choose File to Upload
window.

c. Select the appropriate Template from the drop-
down list.

d. Select the appropriate Tax identification
number from the drop-down list.

e. Select Comingled from the Type drop-down list.
6. Click Continue. They system displays the Import file

[Import File Name] page.
7. For each batch that populates in the ACH Comingled

file, specify whether the system discards, saves, or
processes the batch by selecting Discard, Save or
Process for each batch.
Note:

If you select the Discard All option but do not 
want to discard all batches, ensure that you 
mark or save at least one of the batches in 
the ACH Comingled file for processing.

8. Click Complete ACH, then answer the Security
Challenge by clicking the button on your token and
typing in the number that is displayed. The system
displays a message indicating the status of the file.

9. Click Return to ACH Activity. The system displays
the Activity tab page.

10.Repeat steps 2 through 9 to import additional ACH
Comingled files.

11.Sign out of eCorp Business Online Banking.
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Review ACH Templates
Approve new or modified ACH Transfer Templates before the template is available to use in a live environment with the 
Review ACH Template functionality.

Review ACH templates
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Administration. The system displays the ACH
Template administration page.

3. Use the Search activity options (for example,
Template type) to locate templates that need
approval.

4. Select the check-box for the appropriate template that
needs approval and click Approve. The system
displays the ACH Template administration page and
adds the approved template to the list of Approved
templates.

5. Optional. Click the Print icon to print the list of
templates that need to approval.

6. Sign out of eCorp Business Online Banking.
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Reverse ACH Transfers
Quickly reverse ACH transactions by inquiring into a batch or a specific transaction. This enables you to easily reverse a 
specific transaction, multiple transactions, or an entire batch. The system processes reversals and memo posts to all affected 
accounts.

To reverse an ACH transfer
1. Sign in to eCorp Business Online Banking. The 

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays 
the Payments & Transfers page.

3. Select ACH. The system displays the ACH Activity 
page.

4. Click Reverse for the associated transfer. The system 
displays the transfer page.

5. Click Reverse ACH. The system displays the
ACH List page. 

6. Select Pay to/Pay From account (this will be your 
West Bank account, and should be the original 
account you used with this ACH transactions).

7. Enter dollar amount to be reversed, total withdrawal 
and total deposit number should match.  

8. Click Complete ACH Reversal.

9. Next, answer the Security Challenge by clicking the 
button on your token and typing in the number that is 
displayed. The system will then display the 
confirmation page.

10. Sign out of eCorp Business Online Banking.



Establish a New ACH Template
The ACH transfer system provides easy-to-use templates for many transfer types, including payroll, tax payments, consumer
debits and credits, cash concentration, disbursements, and vendor payments. ACH Transfer templates enable you to
automatically define information about the receiving institution and to addmultiple ACH transfers using easy to use templates.
You can leverage all templates at any time, without having to reestablish each transfer one at a time. Any time that you
generate or process a new template, the system requires approvals in order for it to process transfers as accurately as
possible.
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Note:
To establish templates based on NACHA
standard or non-NACHA (fixed width or
delimited) file formats, use the ACH File
Import Template function.

Establish a new ACH transfer template
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Click the Templates tab. The system displays a list of
available templates.

5. Click + New payment template. The system displays
the New payment template dialog box.

6. Select Payroll - PPD from the Type drop-down list
and click Continue. The system displays the New
Template page.
Note:

Weuse thePayroll - PPD as an example
only.

7. Complete the following:
a. Type a Template name.
b. Select the Tax identification number from the

drop-down list.
c. Select the Template group from the drop-down

list.
d. Select theRepeat check box if the template is for

recurring transfers.
e. Type the From amount.
f. Type the To amount.
g. Select the Frequency from the drop-down list.

8. In the User access section, complete the following:
a. To enable the template for all users select All

current and future users.
b. To enable the template for specific users, select

Specific users. Select the appropriate check
boxes for each user that you want to have access
to the template.

9. In the Pay from section, complete the following:
a. Optional. Type theAccount number to filter by the

account number of the Originating Depository
Financial Institution (ODFI).

b. Optional. Type theAmount to filter by the amount
to be paid from the specified accounts to be
debited.

c. Optional. Type the Identification to filter by the
identification number that the system associates
with the originator of the transfer.

d. Optional. Type theName, to filter by the name of
the customer that the system associates with the
account it debits from.

e. Optional. Click thePay all switch to turn on the
Hold option for all transfers in the batch.

f. Type the Identification.
g. Type theName.
h. Optional. Type any Discretionary data.
i. Optional. Type thePayment information to

include notes about the transfer.

10. In the Pay to section, complete the following:
a. Type theName of the recipient.
b. Type the Identification number of the recipient.
c. Type theRouting transit number of recipient.
d. Type theAccount number of the recipient.



e. Select the appropriateAccount type from the
drop-down list.

f. Type theAmount to deposit in the recipient's
account.

11. Select the appropriate Template Group from the
drop-down list.

12. Click Save.

13. Sign out of eCorp Business Online Banking.
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Edit an ACH Template
You can modify ACH templates using Edit template 
functionality.

Edit an ACH transfer template
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Click the Templates tab. The system displays a list of
available templates.

5. Click Edit for the template that you want to edit. The
system displays the Edit template dialog box.

6. In the Description section, modify the Template
name, Template group, From account, and To
amount as needed.

7. In the User access section, modify any user access
specifications as needed.

8. Modify the information in the fields populating the Pay
from section and the Pay to section as needed.

9. Click Save.

10.Sign out of eCorp Business Online Banking.
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Delete an ACH Template
Delete Template functionality enables you to delete templates that you no longer have a need 
for.

Delete a transfer template
1. Sign in to eCorp Business Online Banking. The

system displays eCorp Business Online Banking.

2. Select Payments & Transfers. The system displays
the Payments & Transfers page.

3. Select ACH. The system displays the ACH transfer
page.

4. Click the Templates tab. The system displays a list of
available templates.

5. Click Delete for the template that you want to delete.
The system displays the delete Template page for the
template that you specified.

6. Click Delete Template. The system displays the
Templates page.

7. Sign out of eCorp Business Online Banking.
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